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Overview

This paper shows a faster, easier, and more automated way to allocate income and expense
from cost pool or "overhead" classes to other classes in nonprofit organizations (NPOs), using 
ManagePLUS Gold for QuickBooks. It demonstrates:

Allocating indirect expense using drag-and-drop, with very little typing.

Allocating indirect expense among multiple classes based on management quantities
("cost drivers")—things like staff hours or direct program spending—which you have associated
with individual classes.

Creating allocation Journal Entries (JEs) automatically.

Sending the JEs to QuickBooks with a single mouse click.

The examples in this paper are very visual (lots of screen shots), but they also (1) serve as
partial user's guide for working with ManagePLUS Gold in a NPO, and (2) include specific
examples related to the accounting requirements for NPOs working with Federal grants and
contracts. So if you're only wanting a general idea of how ManagePLUS Gold might benefit the
accounting processes in your organization, feel free to skip the technical details for now and "just
look at the pictures". You can always come back for the details later.

Want to go directly to the visual examples? Jump ahead to the Creating
allocations topic to see drag-and-drop allocation in action!
 

Using Classes for Activity-Based Costing in Nonprofit Organizations

QuickBooks is a good choice for many nonprofit organizations (NPOs)
because it is easy to use and flexible enough to support the
specialized accounting needs of NPOs. One of the great features
QuickBooks offers for NPOs is the classes feature.

Classes let you identify revenue and expenses with specific programs
and activities of your organization, not just the financial (income and
expense) categories in your chart of accounts. Setting up classes in
QuickBooks to represent your organization's programs and activities,
and assigning those classes when coding transactions, provides two
major benefits:

1. It allows evaluating each program or activity separately, independent of the others, by
associating revenues and costs with specific programs and activities. This supports a form of
cost accounting known as activity-based costing (ABC). ABC is a valuable management tool
because it gives managers, lenders, boards, and funding sources the information they need for
separately considering the effectiveness (benefits vs. costs) of each program and activity. ABC
lets you prepare a profit and loss report for each program and activity, independent of the
others. Audited reports normally provide this kind of cost information, separately for each
major program of the organization. 

2. It supports meeting external reporting requirements such as for Federal filings. IRS Form
990 requires that expenses be broken down into Program, Management, and Fundraising

http://www.goflagship.com/products/mphome.htm
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categories. Using classes to represent programs and activities such as fundraising helps to get
this done.

Deciding which class to assign when entering a transaction is simple in most cases. Donations
received at your organization's booth during an annual charity event are fundraising income, and
if you have a Fundraising class that's the one you'll choose when recording the receipt of those
funds. 

But what about things like office rent? Printer and photocopy paper? Payroll expenses of your IT
department? These may be related to all—or at least several—of the organization's programs
and activities, not any specific one. When entering transactions for things like these, the usual
approach is to assign them to any of several "cost pool" classes you've set up for gathering
categories of non-program-specific costs, usually referred to as indirect expenses. For instance,
you might assign the above-mentioned expenses to a Management & Governance class. Then at
the end of the accounting period (month, quarter, year), you would allocate the amounts
accumulated for Management & General to program- and activity-specific classes. 

Office rent, copy paper, IT salaries, and so on would be referred to as
overhead expenses in a for-profit business. The idea is the same in a NPO:
indirect expenses pertain broadly to several departments/activities/
segments of the organization and must be allocated among the program and
activity classes to which they provided benefits. Assigning and allocating
costs to activities of the business/organization which are responsible for
them or benefit from them, is the essence of activity-based costing.

In QuickBooks, allocation is typically accomplished by:

1. Determining a basis on which to allocate each cost pool to specific programs and
activities. If your organization has a building used both for office space and for assembling
personal hygiene kits for distribution in poverty-stricken areas, you could allocate the building's
depreciation expense based on the number of square feet devoted to each activity—i.e., to
classes named Management & Governance, and Public Health Program #1, for instance. 

2. Calculating the dollar amounts involved. For example, if 1600 square feet is devoted to
office space and 6400 square feet is devoted to health kit assembly (a total of 8000 square
feet), Management & Governance should be allocated 1600/8000 of the total depreciation
expense for the building.

3. Making Journal Entries (JEs) to assign the dollar amounts to those classes receiving the
allocations.

Allocation frequently involves several receiving or "target" classes, so quite a few calculations
may be necessary—you might need to allocate the Management & Governance cost pool among
Fundraising, Member Development, Public Education, Habitat Restoration, Lobbying, etc. So
steps 1 and 2 are typically done outside of QuickBooks, in a spreadsheet such as Microsoft
Excel. Step 3 however, requires manually making JEs in QuickBooks, and is subject to the usual
typing errors, transposition errors, and same old "debits vs. credits" confusion which can muddle
data entry from time to time, especially for inexperienced accountants.

This paper shows how to automate all three of these steps—yes, even the creation of JEs—
with an inexpensive QuickBooks add-on called ManagePLUS Gold for QuickBooks.
ManagePLUS Gold provides a quick, easy, approach for calculating and entering allocations,
which is also more automated and less error prone than the common spreadsheet-and-Journal-
Entry approach. For detailed information about the ManagePLUS Gold product, go here:

http://www.goflagship.com/products/mphome.htm
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"How do I get started with activity-based costing?"

This paper doesn't spend much time on either accounting theory or on ideas for setting up
QuickBooks classes and accounts. A number of excellent resources are available as books, and
as white papers, blog articles, etc. on the Web. One of the best of these is a paper by Christine
L. Manor, CPA, titled Using Classes in QuickBooks to Track Activities. It is a free download
available at several locations on the Web. Here's one of them:

 http://nccsdataweb.urban.org/kbfiles/309/manor-Using-classes-v4.doc

Christine's paper is brief (15 pages), well written, and well worth printing out to use as a
reference if you are getting started with accounting for a NPO. (Christine also has authored a
book which may be helpful, QuickBooks for Not-for-Profit Organizations, though I have not yet
reviewed it personally.)

If you are unfamiliar with using classes in NPOs the information in
Christine's paper is nearly essential for understanding the ideas presented
in this paper. So if you need some background information please read
Christine Manor's paper.

Update: Upon learning that I had cited her paper, Christine Manor was
gracious enough to review this  paper and provide valuable comments. So
you are reading an updated version which incorporates some of her
suggestions. However, any errors or omissions remain fully my
responsibility. - the Author.

QuickBooks itself also offers some assistance with accounting for a NPO. The sample
QuickBooks company file for nonprofits has a broad range of transactions, plus a good example
Chart of Accounts and Classes list to help you get started. And as you probably already know, a
separate edition of QuickBooks is available for NPOs, called QuickBooks Premier for Nonprofits.

QuickBooks Prem ier for Nonprofits doesn't really offer any unique
features. It's mostly a repackaging of standard QuickBooks
Premier features for marketing purposes. For instance, the
"special" nonprofit reports in this edition are simply re-labeled or
customized versions of reports available in all Premier editions.

Among the QuickBooks Premier editions, my personal preference
is QuickBooks Prem ier Accountant because it really does offer
features not available in other Premier editions, such as Client
Data Review.

ABC and Federal grants and contracts

If your NPO receives Federal grants or has Federal contracts, you must follow the accounting
requirements defined in Office of Management & Budget Circular A-122 (http://www.whitehouse.
gov/omb/circulars_a122_2004/). That document prescribes very specific ABC approaches you
must use for allocating the organization's expenses to its programs and activities.

In a for-profit business, allocation methods are the choice of accountants

http://www.goflagship.com/products/mphome.htm
http://nccsdataweb.urban.org/kbfiles/309/manor-Using-classes-v4.doc
http://www.sleeterstore.com/servlet/detail?no=149
http://www.whitehouse.gov/omb/circulars_a122_2004/
http://www.whitehouse.gov/omb/circulars_a122_2004/
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and/or managers. They may be based on a simple estimate ("I think 10% of
Office & Administrative expense should be charged to Department A") or on
some physical or financial factor related to the classes receiving the
allocations—tons of production, gallons of fuel consumed, dollars of direct
expense, etc.

In nonprofits working with Federal programs, cost allocation is
constrained by Circular A-122's rules about the specific allocation bases
which must be used for different kinds of indirect costs.

The rules in Circular A-122 are quite specific but most of them aren't anything unusual. The
examples in this paper should help you with allocating expenses according to the Circular A-122
requirements.

A Few "Ground Rules"...

Examples

To prevent accounting details from clouding your view of the basic allocation ideas, the examples
in this paper are based on a simplified set of classes. You'll likely use a more comprehensive set
of classes in your organization—the "real world" Classes list proposed in the Manor paper
mentioned above has more than 30 classes in it, for example.

And understand that these are contrived examples. Hopefully seeing a few numbers which don't
appear to be realistic (because they aren't!) won't distract from the information being conveyed.
The examples were built for simplicity, not reality.

Glossary

Definitions of few important terms:

activities Refers to various activities/areas/departments/segments of your
organization which you have identified as distinct from others, such as
Fundraising, Member Development, Management & Governance, IT
Department Costs, Facilities Costs, Habitat Restoration, Public Education,
etc.

Identifying activities divides the work within the organization into "chunks"
which can be evaluated separately for management decision making ("Is
our IT department cost effective, or should we consider hiring outside IT
services?"). You'll normally set up a QuickBooks class for each major
activity, so you can separately track the revenue and expense associated
with it.

programs Programs are a subset of the organization's activities. This term implies
activities which deliver goods and services to the organization's
beneficiaries; activities which represent the organization's primary
missions, goals, and work.

Their analog in the for-profit business world would be a profit center.
While the goal is not profits in an NPO the concept is still similar, because
programs represent the "output" of the organization.

supporting services Any major activity which isn't a program is normally a supporting service,
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which makes supporting services the "other" subset of the organization's
activities. This term implies activities which are necessary to the overall
functioning of the organization but are only indirectly related to delivering
goods and services to the organization's beneficiaries.

Their analog in the for-profit business world would be a cost center or
support center—areas of the business which don't directly produce an
output of the business but are nonetheless necessary for the business to
function.

Steps for Allocating Income and Expense

When you've reached the end of an accounting period and you're ready to allocate cost pool
(overhead) classes with ManagePLUS Gold, typically you'll follow these steps:

1. Prepare for allocation by selecting an accounting period to work with in ManagePLUS Gold,
refreshing transactions and lists from QuickBooks, and updating management quantities
associated with your classes. 

2. Create allocations. Most of your effort will be needed the first time you use ManagePLUS
Gold. Creating allocations in subsequent periods will be much quicker:  you'll just review (and
if necessary, adjust) your allocation setups, then send Journal Entries to QuickBooks.

3. Find and fix "unclassified" amounts. These result when no class was assigned to some
transactions. Such amounts need to be assigned a class so that nothing gets "missed" in the
accounting for revenue and cost flows to your various program and activity classes.

4. Send allocation Journal Entries to QuickBooks—with just a click of the mouse.

5. View your allocations in reports such as the Profit and Loss by Class report in QuickBooks,
or ManagePLUS Gold's Profit Analysis report.

1. Preparing to allocate
This section describes things you should (almost always) do before creating allocations with
ManagePLUS Gold. 

First, a few basics...

Since this is a "crash course" in using ManagePLUS Gold, here are a couple things you ought to
know:

Here's a look at the ManagePLUS Gold main window; in this case, after opening the Chart of
Accounts, Classes, and Transaction tabs:
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Most of the program's commands are accessible via toolbar buttons and from the main menu.

The main toolbar is the one at the top, which begins with Open, Close, Period, etc. buttons.

Each tab also has its own toolbar, with buttons for commands that work within that tab. In the
illustration above, the Transactions tab toolbar has buttons for Refresh, Grid, Format, etc.

Why all the different colors? User-definable colors identify data in the
program's windows and reports. For example, the Classes tab is colored gold
in the screen shot above, so class-related data will be highlighted in gold on
certain reports.

Select an accounting period to work with

Click the Period button in the main toolbar, then either select an existing accounting period or
define a new one. An accounting period can be any range of dates you want, though you'll
typically work with a standard period such as a month, quarter, or year.

You work with one specific accounting period at a time in ManagePLUS Gold,
referred to as the active accounting period.

When defining a new accounting period you'll usually copy
your allocation setups from a prior period, to use them
as a starting point for the new period's allocations.

See:  Re-using your allocation setups in the Miscellaneous
Ideas & Tasks section.
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Refresh accounts, classes, transactions

You need to refresh ManagePLUS Gold's copy of your QuickBooks data to be sure it is current.

1. Open the Chart of Accounts, Classes, and Transactions tabs by clicking on their buttons in
the main toolbar. 

        

2. After you open each tab, click on its Refresh button to refresh that window's data from
QuickBooks: 

You aren't required to refresh everything:  if your Chart of Accounts and
Classes lists haven't changed, you really only need to refresh transactions.
But refreshing everything takes seconds and is good insurance against
working with outdated data.

Update management quantities (cost drivers) associated with your classes

Managem ent quantities are physical or dollar amounts
which you associate with individual classes in ManagePLUS
Gold. They can be anything you want, but typical examples
would be staff hours spent on each of your organization's
programs, square feet of building space, or direct spending
on each program.

Cost driver is the more standard activity-based
costing term.  They're called management
quantities in ManagePLUS Gold because they
have several alternate uses, not just as cost
allocation bases.

Associating management quantities with your classes lets you
allocate to multiple classes automatically in proportion to a
particular allocation basis (staff hours, direct spending, etc.),
the same as if you had done calculations in a spreadsheet—
but without having to create spreadsheet formulas.

See:  Assigning management quantities in the First-Time
Setup section.

This step is only necessary for allocations which are to be done on a specific basis such as
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staff hours or direct program spending—which is the case for most of the cost allocation
methods allowed for NPOs.

For this paper's simplified example, management quantities representing staff hours devoted to
each program are associated with the organization's program classes. Here is a screen shot of
the Classes window with the staff hours entered:

Program A, Program B, and Program C represent fictitious programs.
Real-world examples might be Public Education, Habitat Restoration, or
Cancer Research.

See Assigning management quantities in the First-Time Setup section for
information about entering management quantities. 

2. Creating allocations
Creating allocations in ManagePLUS Gold is mostly a simple, drag-and-drop process. It takes a
few minutes to set up allocations the first time you do it. But the next time it won't take long at all,
because you can re-use your allocation setups in subsequent accounting periods.

See Re-using your allocation setups in the Miscellaneous Ideas & Tasks
section.

This section tells how to explore allocation information in the ManagePLUS Gold Classes
window, and how to create or change allocations among classes.



QuickBooks for Nonprofits:  Allocating Costs to Program and Activity Classes10

Copyright © 2012 Flagship Technologies, Inc. All rights reserved. (Rev. 4/21/2012)

Comment from Christine L. Manor, CPA:  

"Reading your paper may suggest to some people that all
adm inistrative costs can be allocated. That is true, w ith some
caveats."

"Truly common costs like rent should be allocated to all classes,
program  and supporting. Some supporting costs, like IT, may also
need to be allocated to all the rest of the classes. Adm in and
Fundraising costs need to stay in their own classes for audited reports
and the Form  990. Some organizations may want to allocate Adm in
and Fundraising to the rest of the classes for a “fully-loaded” picture of
each class. This should be done “below the line.” A special Other
Expense account should be used."

"OMB A-122 (http://www.whitehouse.gov/omb/circulars_a122_2004/)
is the guiding document for how recipients of federal awards
(contracts and grants) must account for overhead expenses."

To assure that your allocation methods pass muster for audited
reports and for Federal reporting (IRS Form 990), seek the advice of a
qualified accounting professional before implementing them.

Carefully document your allocation methods so that you can defend
the rationale on which they are based, to anyone who asks. ManagePLUS
Gold helps with this, because it can preserve the details of allocation
methods you used in each accounting period.

About the Allocation Information columns

Both the Classes and Chart of Accounts windows have columns devoted to allocation-related
details, the headings of which have a lavender background by default, as you can see in the
screen shot below. 

The purpose of these columns isn't as cryptic as it may at first appear. The learn the purpose of
any column, just double-click any cell in it. That will display a dialog with details about how the
cell's amount was calculated. For instance, double-clicking the cell indicated by the red box in
the screen shot below will open the dialog shown beneath it.

Besides double-clicking, you may also right-click on a cell and choose Edit /

View cell details from a pop-up menu.

http://www.whitehouse.gov/omb/circulars_a122_2004/
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The dialog shown above explains the Available to Allocate cell on the Office & Admin class' row.
It tells us that the entire amount available to allocate from Office & Admin comes directly from
QuickBooks transactions (i.e., the Direct from transactions line). We can also see that Office &
Admin has not received allocations from any other classes, because the IN from other accounts
& classes line is zero.

The OUT (allocated to others) column is the most important one!

Double-clicking it opens the Allocated OUT (to others) dialog, which lets you create or edit
allocations, as you will see later. 
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The examples which follow refer to many of the features of the Allocated OUT (to others)
dialog, labeled above. 

Example 1:  Allocating Office & Admin expense, based on staff hours

This allocation scenario is only an example, to show how to accomplish
this type of allocation using ManagePLUS Gold. Consult Office of
Management & Budget Circular A-122 (http://www.whitehouse.gov/omb/
circulars_a122_2004/) or seek the advice of a qualified accounting

http://www.whitehouse.gov/omb/circulars_a122_2004/
http://www.whitehouse.gov/omb/circulars_a122_2004/
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professional before applying allocations.

The number of staff hours devoted to each program seems to be a reasonable basis for
allocating overhead expenses ("cost pool" classes) to the various program classes. Let's do that
for Office & Admin expense:

1. Double-click the OUT (allocated to others) cell for the Office & Admin class. 

This is illustrated by the example in the screen shot shown above, except there won't be any
allocation lines in the left pane yet.

2. Drag the [A] token into the right pane and drop it onto Program C.

Classes can have two management quantities associated with them—an "A"
and a "B" quantity. Dragging the [A] token creates an allocation based on
the "A" management quantity. (See Assigning management quantities in the
First-Time Setup section.)

This creates an allocation from Office & Admin to the Program C class based on the
management quantity we associated with Program C (315 hours):

3. Drag the [A] token again, but drop it onto Program A this time

4. Finally, drag the [A] token and drop it onto Program B.
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When you're done, the dialog will appear as follows:

A couple things to note:

All three allocations were made without typing anything.

The % and Amount columns were calculated automatically.

5. Click OK to close the dialog.

After you do, notice that the three allocation amounts appear in the IN (allocations from
others) cells of the program classes (the red box in the screen shot below). Also, the OUT
(allocated to others) amount is $77,644.12 for Office & Admin, while the Unallocated cell is
now blank (zero), as illustrated by the blue box in the screen shot.
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Example 2:  Allocating Travel expense, by percentages

This allocation scenario is only an example, to show how to accomplish
this type of allocation using ManagePLUS Gold. Allocating by fixed
percentages may not be allowed for most expense types in NPOs. Consult
Office of Management & Budget Circular A-122 (http://www.whitehouse.
gov/omb/circulars_a122_2004/) or seek the advice of a qualified accounting
professional before applying allocations.

How should we allocate management's travel expenses? We could allocate them based on staff
hours, but one of the managers has told us that more travel expense should be allocated to
Program C—it's a relatively new program and they devoted a lot more travel to it, in getting it
started. Staff hours aren't a good fit for doing this, so we can allocate by using percentages.

If you are unfamiliar with using classes in NPOs, or with activity-based
costing, the information in Christine's paper is nearly essential for
understanding the ideas presented in this paper. So if you need some
background information please read Christine Manor's paper before
continuing.

1. Double-click the OUT (allocated to others) cell for the Travel class. 

The Allocated OUT (to others) dialog will open.

2. Drag the [%] token into the right pane and drop it onto Program C. 

Management has told us to allocate 50% of travel expenses to Program C, so...

3. Type 50 in the % column of the new allocation line, then press the Enter key.

http://www.whitehouse.gov/omb/circulars_a122_2004/
http://www.whitehouse.gov/omb/circulars_a122_2004/
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4. Drag the [%] token again, and drop it onto Program A. 

5. Type 20 in the % column of the new allocation line, then press Enter.

6. Finally, drag the [%] token once more and drop it onto Program B.

ManagePLUS Gold keeps track of the remaining unallocated percentage and auto-fills the %
column, so this time you don't have to type anything. Here's how the dialog should look:

7. Click OK to close the dialog.

In the Classes window, notice that amounts in the IN (allocations from others) column have
increased again for the three program classes—by the amounts of our just-now-added
allocations. Let's have a look at one of them...
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8. Double-click the IN (allocations from others) cell for Program C,

That will open the Allocated IN (from others) dialog, shown below. It lists the allocations
Program C has received from Office & Admin and from Travel—the allocation we just now
created, in the prior steps.

9. Click Close to close the dialog.

Example 3:  Allocating IT Department expense, by percentages and staff hours

This allocation scenario is only an example, to show how to accomplish
this type of allocation using ManagePLUS Gold. Allocating by fixed
percentages may not be allowed for most expense types in NPOs. Consult
Office of Management & Budget Circular A-122 (http://www.whitehouse.
gov/omb/circulars_a122_2004/) or seek the advice of a qualified accounting
professional before applying allocations.

Management believes it would be reasonable to allocate IT Department costs:

20% to Office & Admin

40% to Fundraising

The remaining portion to program classes, based on staff hours.

http://www.whitehouse.gov/omb/circulars_a122_2004/
http://www.whitehouse.gov/omb/circulars_a122_2004/
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 But wait! We already allocated Office & Admin's
expenses back in Example 1! After we allocate some of the
IT Department expense to Office & Admin, won't we have to
go back and re-allocate Office & Adm in again?

No, because ManagePLUS Gold works like a
spreadsheet. If one formula depends on another, changing
the first one automatically updates the second one.The IT
Department expenses we allocate to Office & Admin here, will
automatically flow through to the program classes which are
targets of Office & Admin's allocations. 

In other words, allocations can "cascade" through any
number of classes.

Make the percentage allocations first

We make the percentage allocations first, so that whatever amount is left over can be allocated
based on staff hours.

1. Double-click the OUT (allocated to others) cell for the IT Dept. class. 

The Allocated OUT (to others) dialog will open.

2. Drag the [%] token into the right pane and drop it onto Office & Admin. 
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 "Hey, w ait a m inute...can w e do that? I thought w e
could only allocate to program  classes..." 

It's quite common for support center or "cost center"
activities to allocate expense to other cost centers or support
centers. In fact, handling some allocations this way can make
them more accurate.

How? The manager of the IT Department may not have a
good idea of what portion of his department's effort was
devoted to each program—unless IT only worked directly with
 individual programs, which it doesn't. But he may have a
good idea of what portion of the IT Department's time was
spent supporting the main office staff (Office & Admin) and
on fundraising activities.

Using the best estimates provided by support activity
managers, about how their department contributed to other
activities (whether directly to programs, or to other support
activities) should ultimately result in the most accurate
allocation of expenses to programs.

3. Type 20 in the % column of the new allocation line, then press the Enter key.

4. Drag the [%] token again, and drop it onto Fundraising. 

5. Type 40 in the % column of the new allocation line, then press Enter.

The dialog should now look something like this. As the red box indicates, 40% of IT Dept.
expense remains unallocated at this point.
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Now, make the remaining allocations, based on staff hours

6. Drag the [A] token into the right pane and drop it onto Program A.

7. Drag the [A] token again, and drop it onto Program B.

8. Finally, drag the [A] token and drop it onto Program C.

When you're done, the dialog should appear as follows. Note that the upper part of the left
pane shows the percentage-based allocations, and the lower part shows management
quantity-based allocations.

9. Click OK to close the dialog.

Here's how the Classes window should look now. The blue box shows that no Unallocated
amounts remain for Office & Admin, IT Dept., or Travel (it's empty; meaning the cells are zero).
The red box shows allocation amounts received by the various classes (expense amounts
appear as positive numbers for "cost center" classes and as negative numbers for "profit
center" classes).
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There's a lot more we could explore, but these examples give you an idea of how quick and easy
it is to make allocations with ManagePLUS Gold.

3. Finding and "fixing" unclassified amounts
A primary goal of activity-based costing is to fully charge all revenue and expense with the
organization's various programs. Otherwise, profit and loss reports for each program may
underestimate the costs of providing those programs, and distort management's view of program
benefits versus delivery costs.

To capture all revenue and expense in this way, every transaction involving income or expense
should be assigned a class when it is entered. But forgetting to assign a class is easy to do, so
it's important to check for unclassified amounts and assign the appropriate class(es) to them.

Both QuickBooks and ManagePLUS Gold offer easy ways to find and "fix" unclassified amounts,
and each has advantages:

The QuickBooks approach is best when you need to evaluate unclassified transactions
individually and want to assign classes directly to the original transactions.

The ManagePLUS Gold approach is best for "wholesale" assignment of an unclassified
amount to a class. It is equivalent to making Journal Entries to classify unclassified amounts
but is much easier—it works with drag-and-drop simplicity.

Finding and fixing unclassified transactions in QuickBooks

1. Open a Profit and Loss by Class report for the accounting period you are working with. 

2. Scroll to the far right side of the report.

If a class was not assigned to any transaction(s), a column named Unclassified will be
present.
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3. Double-click any number in the Unclassified column to open a list of unclassified
transactions for the account listed on that row.

Or, you can double-click the amount on the Net Income row to open a list
showing all unclassified income and expense transactions.

If we double-click the $548.55 amount on the Supplies row, a window like this will open:

4. If we double-click a transaction line as shown above, the original transaction will open and
we can assign a class to it (Office & Admin in this case):
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You can find and fix all unclassified amounts using these same techniques.

Or...there's Client Data Review. If you have the QuickBooks Premier (or
Enterprise) Accountant edition, its Client Data Review (CDR) feature gives
you another alternative for reclassifying transactions. CDR will  let you apply
classes to batches of transactions if desired, which is obviously faster than
classifying transactions individually.

But CDR won't allow you to split unclassified amounts among multiple
classes or change dollar amounts of existing class splits. For that you need
to either (1) edit the original transactions, or (2) use Journal Entries to
assign amounts to classes, or (3) use a tool like ManagePLUS Gold, as
described below.

Finding and fixing unclassified transactions in ManagePLUS Gold

1. Go to the Chart of Accounts window by clicking on either the Accounts button in the toolbar
or on the Chart of Accounts tab if it is already open. 

2. Scroll to the right in the Chart of Accounts window, until the Unallocated column is visible.
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3. Scroll downward, looking for numbers in red boldface in the Unallocated column...as
illustrated by the blue box in the screen shot below.

When an account has unclassified amounts, they show up in the Unallocated column.
Amounts from subaccounts are totaled at the parent account level and shown there in red
boldface text. This screen shot shows the same $548.55 unclassified amount for Supplies
expense, as in the QuickBooks examples above.

The red boldface text is applied at the parent account level to let you know
that you have the option of applying a class(es) to the entire unclassified
amount directly from  the parent account, rather than having to do so
individually for each subaccount.

4. If we double-click the OUT (allocated to others) cell on the Supplies row, the Allocated OUT
(to others) dialog will open, where we can assign the unclassified amount to a class—or split it
among any number classes, if we want.

In this case we want to assign the entire amount to the Office & Admin class, just as we did in
the QuickBooks example. 

5. We allocate 100% of it to Office & Admin, by dragging the [%] token onto Office & Admin
in the right pane.

Here's the result. As the red arrows indicate, ManagePLUS Gold has allocated 100% to
Office & Admin.
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Could we have split Supplies expense among several classes? Yes. All
of the same allocation methods shown earlier in the Creating allocations
section are available here too.

6. Click OK to close the dialog.

Though we've assigned Supplies expense to the Office & Admin class here in
ManagePLUS Gold, the result won't show up in QuickBooks until we send
Journal Entries to QuickBooks, as described in the next section.
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For some expenses the easiest way to assign classes is to do
so after completing the accounting period.

Consider something like a utility expense—electricity for instance—
which you always split among two or more classes according to a set
percentage; maybe 60% to Office & Admin, and 40% to the IT Dept.

Using QuickBooks' memorized transaction feature simplifies splitting
the electricity bill among classes somewhat, and QuickBooks'
calculator capabilities help too, but still you have to manually calculate
the dollar amount of each split. Especially if you (or whoever is
entering transactions) are splitting the expense among more than two
classes, this both takes extra time and introduces more opportunity
for errors—like mistyping the desired percentage of one of the splits.

An easier way, is to simply leave electricity expense unclassified
when you enter it. Then use ManagePLUS Gold at the end of the
accounting period to split electricity expense among the desired
classes, using the drag-and-drop approaches shown in this paper.

This works well for many expense types which don't necessarily need
to be classified at the time of transaction entry. It also works in those
situations where you've "inherited" a set of QuickBooks records and
are asked to generate some meaningful management information from
them!

4. Sending allocation Journal Entries to
QuickBooks

Sending Journal Entries to QuickBooks

1. Click the Send button in the main toolbar, then follow the prompts. 

That all there is to it. When the process has finished—it takes just seconds—all of your
ManagePLUS Gold allocations will be represented in QuickBooks as Journal Entries.

Things to know:

The JEs created in QuickBooks will be dated as of the last day of the active accounting
period.

ManagePLUS Gold may update the QuickBooks Chart of Accounts before it sends the JEs.
(See What goes on behind the scenes, below, for details.)

To see the JEs before sending them, look at the Seeing your allocation transactions in
ManagePLUS Gold topic in the Miscellaneous Ideas & Tasks section.
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Updating allocations and re-sending the Journal Entries

Suppose you've created allocations in ManagePLUS Gold and sent their Journal Entries to
QuickBooks. But later you edit some transaction amounts on which the allocations were based.
Or maybe you decide to change allocation percentages or methods, or change some of the
management quantities referred to by your allocation setups. How can you update your
allocations?

1. Open ManagePLUS Gold to the desired accounting period.

By default, it opens to the same period you worked with last time.

2. Refresh transactions from QuickBooks.

This step is only necessary if you've made any transaction changes in QuickBooks, for the
period.

3. Change your allocation setups or management quantities, etc., if desired.

This step is optional. If you only need to update allocations due to changes in the transaction
amounts they are based on, you may leave your allocation setups unchanged:  ManagePLUS
Gold will automatically re-apply them to the updated transaction amounts.

4. Send Journal Entries to QuickBooks again.

ManagePLUS Gold will delete the old JEs and replace them with updated ones.

What goes on behind the scenes (the technical stuff)

When you click on the Send button to send Journal Entries to QuickBooks, ManagePLUS Gold:

1. Deletes old allocation transactions from QuickBooks, for the active accounting period. 

This assures no old transactions (created by ManagePLUS Gold) exist in QuickBooks within
the dates of the active accounting period. Transactions outside the active accounting period's
date range are ignored.

2. Synchronizes with the QuickBooks Chart of Accounts.

When you add or change allocation formulas, ManagePLUS Gold builds a new set of
allocation transactions. But before doing that, it creates accounts in the Chart of Accounts
window, as needed, to mimic the cost center and profit center classes involved in the
allocations. These ManagePLUS Gold-created accounts are added to the QuickBooks Chart
of Accounts before transactions are sent. (In some cases, ManagePLUS Gold-created
accounts may be deleted or renamed.)

See How ManagePLUS Gold updates the QuickBooks Chart of Accounts, below, for details.

3. Sends the transactions.

This is the simplest part of the process. With old transactions deleted and the necessary
accounts in place, ManagePLUS Gold simply sends the allocation JE transactions to
QuickBooks.
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How ManagePLUS Gold updates the QuickBooks Chart of Accounts

It handles updating of the QuickBooks Chart of Accounts automatically.

It creates, renames, and manages a group of Other Expense type accounts, with an account
named Allocated Expense (MP) as the parent account, and a single level of subaccounts
below it.

It manages the names of these subaccounts and may rename them at any time, so that their
names always correspond to the classes they represent.

While you may rename these subaccounts' in QuickBooks, your renaming
may be temporary. If you later change any class names, and those classes
are involved in allocation, ManagePLUS Gold will rename the corresponding
subaccounts to correspond to the names of the classes they represent.

You may freely rename the the Allocated Expense (MP) account, and ManagePLUS Gold
will leave the new name unchanged.

How Allocated Expense (MP) subaccounts are named

The names of these subaccounts mimic the "path" to the classes they represent. So if you have a
class named:

Equipment:Fork Lifts

ManagePLUS Gold will create a subaccount named:

Equipment_Fork Lifts

(An underscore (_) is substituted for the colon (:) which separates the class name levels.)

What identifies ManagePLUS Gold transactions in QuickBooks?

All have "MP~" in their Reference Number and Memo fields.

Do not use "MP~" in the Reference Number or Memo fields of your own
transactions, or ManagePLUS Gold may delete them as part of managing its
own transactions in QuickBooks.

5. Seeing your allocations in reports
After sending Journal Entries to QuickBooks you can see their effect in the Profit and Loss by
Class report. Or, you can use the Profit Analysis report In ManagePLUS Gold, which offers some
unique advantages.

Finding allocations in the Profit and Loss by Class report (QuickBooks)

1. Choose Reports > Company & Financial > Profit and Loss by Class from the QuickBooks main
menu. 

2. Set the report's date range to match the accounting period you are working with.
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3. Scroll down to the bottom of the report and look for the Allocated Expense (MP) section,
indicated by the green bracket in the screen shot below.

 

Notice that the Journal Entries from ManagePLUS Gold have:

Posted allocations to subaccounts of Allocated Expense (MP). 
Example:  Allocations from the Office & Admin class to Program A, Program B, and
Program C are shown on the _Office & Admin (subaccount) line, indicated by the red box.

Posted offset amounts for those allocations to the Allocated Expense (MP) parent account.
Example:  The blue box shows the Office & Admin offset amount.

Finding allocations in the Profit Analysis report (ManagePLUS Gold)

ManagePLUS Gold's Profit Analysis report:

Is a profit and loss report for a single class or a "branch" of the of the class tree (a parent
class and its subclasses).

Is available at any time, so you can see the effects of your allocations immediately, without
sending Journal Entries to QuickBooks.
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Is created in ManagePLUS Gold's internal spreadsheet. Some report cells are "live":  you
can change data in them (play "what-if") and immediately see the effect on the entire report.

Has columns with automatically-generated management statistics, such as showing each
expense on a per-staff-hour basis (or other basis, depending on the management quantities
you have used).

1. Choose Reports > Profit Analysis (for a class) from the ManagePLUS Gold main menu. 

The Modify Report dialog will be displayed.

2. On the Filters tab, select the class you want to view in the report.

Here's an example with the Program C class selected:

3. Click OK.

The report will open in a new tab.

4. Scroll down to the bottom of the report and look for the Allocated Expense (MP) section,
indicated by the green bracket in the example below..
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Things to notice:

This report is for the Program C class, as indicated by the red arrow.

The allocation of Office & Admin expense to Program C is shown in the red box.

Several optional report columns are available to include in the report, many of which
automatically calculate various statistics. The purple box illustrates one of them:  it shows
every expense line on a per-management-quantity basis. In this example we associated a
number of staff hours with each program class, so the $92.43 amount is the Office & Admin
expense per staff hour for Program C. (For details, see Assigning management quantities
in the First-Time Setup section.)

Like QuickBooks reports, ManagePLUS Gold's reports can be exported to Excel if you want
to make changes or additions (the Export button in blue box).
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First-Time Setup

This section provides details on the setup steps required, the first time you use ManagePLUS
Gold with a particular QuickBooks company. Setup typically takes ten minutes or so, but once
you've done it, creating allocations for any period—and for any number of classes—takes only a
couple minutes. 

The steps shown below are the "brief" version. Consult the ManagePLUS
Gold Help system for more detailed explanations, and tutorials.

Connecting to a QuickBooks company, and basic "housekeeping"

1. Start QuickBooks and open the company file you want to work with. 

2. Start ManagePLUS Gold.

The first time you start ManagePLUS Gold the No Company Open window will appear. (If not,
choose File > Open Company... from the main menu.)

3. Click on the Add New Company button.

This will open the Connection Wizard to help you connect the ManagePLUS Gold company
(the one you're adding) and the company that's open in QuickBooks. (ManagePLUS Gold
companies correspond 1:1 to QuickBooks companies.)
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4. Follow the Connection Wizard prompts to establish a connection and to configure
QuickBooks to allow automatic access to accounting data by ManagePLUS Gold.

Once connected, the ManagePLUS Gold window will look something like this:

5. Click the Allocation button in the toolbar, or choose View > Allocation features from the main
menu. 

 The Allocation features dialog will open:

6. Check mark Enable allocation features if it is not check marked already, then click OK to
close the dialog. 

7. Click the Period button in the toolbar.

 The Select Accounting Period dialog will open.

8. Click the Add button to add (define) a new accounting period.

A pop-up dialog will ask for beginning and ending dates for the accounting period you want to
add:  enter the dates, then click OK to close the dialog.
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9. Be sure the period you defined is selected (highlighted, as shown above), then click OK to
close the dialog.

You must always select a specific accounting period to work with, referred to
as the active accounting period in ManagePLUS Gold.

The reason is that ManagePLUS Gold manages extra data related to your
accounts and classes separately for each accounting period. When you
select a particular accounting period to work with, the supplemental data for
that period automatically gets loaded as well.

What kinds of extra data? Among other things, you can associate
management quantities with individual classes:  things like hours of staff
time devoted to a program, direct program spending, etc. ManagePLUS Gold
can use the management quantities you enter to automate making
allocations to classes, and to provide per-management-quantity statistics on
reports—such as showing each expense on a per-staff-hour basis.

Refreshing lists and transactions from QuickBooks

1. Click the Accounts and Classes buttons in the toolbar, to open their windows. 

    

 The first time you click either button, ManagePLUS Gold may ask you to allow refreshing
(importing) the lists from QuickBooks.

2. If asked, click OK to allow ManagePLUS Gold to refresh the list(s). 

3. Click the Transactions button in the toolbar, to open the Transactions window. 

If you're opening the window for the first time, ManagePLUS Gold won't have a copy of the
period's transactions, either. So it will ask you to allow refreshing (importing) transactions from
QuickBooks.

4. Click OK when asked, to allow refreshing transactions.

The Transactions to Refresh dialog will open, to let you choose which months' transactions
you want to refresh.
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5. Click the All button to select all transaction months of the accounting period, then click OK.

The reason you have the option of choosing which months' transactions to refresh, is to save
time:  if you know you've made changes in only one month's transactions, for example, you
only need to refresh that month.

When the refresh has completed, ManagePLUS Gold will have three tabs open and will
appear something like this:

Setting the allocation types for your classes

After you've refreshed classes for the first time, you need to identify the allocation type of each



QuickBooks for Nonprofits:  Allocating Costs to Program and Activity Classes36

Copyright © 2012 Flagship Technologies, Inc. All rights reserved. (Rev. 4/21/2012)

class that you want to involve in allocations. ManagePLUS Gold was designed for the for-profit
business world, so it uses the terms profit center and cost center, and you need to identify
program classes as profit centers, and support service classes as cost centers. This is
something you need to do only once.

Why is this necessary? It partly has to do with making allocation more "user
friendly"—preventing certain kinds of allocation errors—by limiting which
classes can be sources and which can be destinations for allocations. Cost
centers (support services) can be both sources and destinations for
allocations from other classes, but profit centers (programs) can only be
destinations. This makes sense if you think about it:  one support service
class can logically contribute expenses to another, or to a program class,
but a program class shouldn't ever contribute income or expense to a
support service class.

1. Click on the Classes tab. 

2. Click in the Alloc type column on the desired row. (See the illustration below.)

A down arrow will appear.

3. Click the down arrow, then select the desired type from the drop-down list.

This illustration shows the Program A class being identified as a profit center.

When you choose an allocation type for any class, all parent and child
classes w ithin the same branch of the class tree get assigned that same
type.

4. Choose a type for each of the classes you want to use in allocations. For example: 
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Assigning management quantities (cost drivers)

Management quantities are physical quantities or dollar amounts which you associate with
individual classes to use as allocation bases for allocating income or expense to those classes. 

Cost driver is the more standard activity-based costing term. They're
called management quantities in ManagePLUS Gold because they have
several alternate uses, not just as a basis for cost allocation.

Assigning management quantities is only necessary for classes that are to receive allocations on
the basis of some physical quantity (staff hours, square feet of building space) or financial
amount (dollars of direct spending). Once you've established allocations based on management
quantities, all you need to do in future periods is update the management quantities with
numbers appropriate for the period. ManagePLUS Gold will automatically take care of allocating
the periods' expenses based on them!

Allocations based on management quantities accomplish what you would do
in a spreadsheet, only easier, with no responsibility to create spreadsheet
formulas, and with fewer opportunities for introducing errors.

%APPGOLD%> also uses management quantities to provide per-unit
statistics on reports, such as showing revenues and expenses on a per-
staff-hour basis, per-dollar-of-direct-spending basis, etc.

You choose the management quantities you want to define and use for each class. However, the
examples in this paper allocate expense based on staff hours associated with individual
programs, so we'll enter staff hours here.

1. Click on the Classes tab if you're not there already. 
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2. Click in a management quantity column where you want to enter information. 

Notice that the Classes window gives you two management quantity
columns, plus unit of measure columns for both of them. We'll only be using
the "A" columns in this example, but if you supply management quantities in
both the "A" and "B" columns for a class, you may allocate to that class
based on either or both management quantities.

3. Type a quantity in the A Mgmt Qty column. 

4. Enter an appropriate unit name in the A unit column, or select one from the field's drop-
down list.

5. Repeat these steps for any classes which should have an associated management quantity.

 Here's an example. We've associated staff hours with program (profit center) classes but could
have done the same for cost center classes as well—and would have, if we intended to
allocate amounts to them on a per-staff-hour basis.
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Where do management quantities come from? 

From wherever you want. In the case of staff hours, you might get
them from timesheets or other payroll reports and/or records you
keep with respect to staff time devoted to each program.

And if some other management data seems to make sense as a basis
for making allocations, by all means consider using it for that purpose.
You are in control of what management quantities to use, and where
to get them...within the limits of allocation bases and methods
prescribed by Office of Management & Budget Circular A-122 (http://
www.whitehouse.gov/omb/circulars_a122_2004/).

Miscellaneous Ideas & Tasks

This section is a "catch-all" collection of details which didn't fit elsewhere and tasks you may want
to do from time to time. 

Re-using your allocation setups (when defining a new accounting period)

Usually when you define a new accounting period in ManagePLUS Gold you'll want to copy your
allocation setups from another (usually prior) period. If you do, you may only need make minor
adjustments to your allocation setups before using them for the new period. 

If your allocations are mostly based on management quantities, updating
the management quantities associated with your classes may be the only
change needed before creating allocations for the new period.

http://www.whitehouse.gov/omb/circulars_a122_2004/
http://www.whitehouse.gov/omb/circulars_a122_2004/
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To re-use (copy) allocation setups when defining a new accounting period:

1. Click the Period button in the main toolbar. 

The Select Accounting Period dialog will open.

2. Click the Add button in the Select Accounting Period dialog, to add (define) a new period.

The Add New Accounting Period dialog will open:

3. Enter beginning and ending dates for the new period.

4. Select the Copy user data from the period selected below option.

5. Select the accounting period you want to copy from, in the bottom part of the dialog, by
clicking on it.

6. Click OK to create the new period and close the dialog.

Viewing allocation transactions in ManagePLUS Gold

ManagePLUS Gold automatically re-creates transactions for your allocations, every time you
make even one small change in your allocation setups. These are the Journal Entries which will
be sent to QuickBooks if you decide to do that, but you can view them in ManagePLUS Gold at
any time:

1. Open the Transactions window by clicking its button in the main toolbar. 

2. Scroll down toward the bottom of the Transactions window.

By default the transactions are sorted by Date. Because allocation transactions are always
dated the last day of the accounting period they should be near the end of the list unless
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you've changed the sort order by clicking on a column heading. (If so, just click the Date
column heading again, to sort by Date.)

3. Look for transactions displayed in alternating shades of lavender, and with reference
numbers which begin with MP~ (for "ManagePLUS").

You cannot edit these transactions:  ManagePLUS Gold automatically re-
creates them, as needed.

Deleting allocation journal entries from QuickBooks

Normally there should be no need to manually delete ManagePLUS Gold's Journal Entries from
QuickBooks. However, the option to delete them from QuickBooks is available if you should want
to do so:

1. Open the desired company in QuickBooks. 

2. Open ManagePLUS Gold to the desired company and accounting period.

3. Click the Delete button in ManagePLUS Gold's main toolbar.

ManagePLUS Gold will delete its Journal Entries from QuickBooks, with the following
limitations. It deletes:

Only Journal Entries with "MP~" in both the Reference Number and Memo fields.

Only transactions within the dates of the active accounting period in ManagePLUS Gold. To
delete Journal Entries for other periods you must open those periods and perform the
deletion in each of them.
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Tip:  How to delete Journal Entries across several
periods...

Define and open a new accounting period in ManagePLUS
Gold which spans the entire range of dates covering the
periods from which you want to delete Journal Entries. For
example, to delete Journal Entries for the past three years,
define an accounting period which spans that three-year
period.

Expanded possibilities for the Classes list

Because ManagePLUS Gold lets you automate allocation of expense from a class to its
subclasses, it opens up new possibilities for arranging the QuickBooks Classes list. For instance,
you can more easily use multiple class levels (parent and child classes) instead of simply having
all classes on the same level.

Here's a portion of a Classes list, in which Education and Habitat Restoration are classes
representing two major program areas, and specific programs are represented as their
subclasses:

Education
Public Ed.
In-school Programs
Teacher Training

Habitat Restoration
Direct
Grants (outgoing)

Why have parent and child class levels?

You can let parent class levels represent broader program areas, while child levels represent
more specifically targeted or specialized areas or programs. The general idea of full costing is
that expense assigned to a parent-level program class should be allocated across its
subclasses on some reasonable basis, and ManagePLUS Gold makes doing that almost
effortless.

Having multiple class levels can help you assign expense "closer" to its appropriate
destination as you enter transactions. 

For example, suppose you hire a graphic and Web designer to develop educational resources
that will be used in the organization's various educational programs--things like pamphlets,
Web pages, classroom worksheets, teacher training materials, etc. While it would be possible
to split this person's salary among specific educational program classes paycheck by
paycheck, it may make more sense to always classify her salary with the Education class. 

You will likely also have other expenses which are strictly related to education but not specific
to any particular educational program. An example might be a purchase of video projectors
which will be used across all of the organization's educational programs. Here again, you could
assign the Education parent class to this transaction, to get the expense "closer" to its ultimate
destination—the various educational program subclasses.
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At the end of each accounting period then, you can use ManagePLUS Gold to allocate the
expense accumulated at the Education class level, to each of its individual program
subclasses.

It's important to remember that in ManagePLUS Gold, allocations can "cascade" to any
number of classes. So you can use any number of program class levels if you want, and each
parent level's accumulated expense can be allocated or "passed down" to its immediate child
classes (subclasses), for as many levels as you have in your Classes list.

You can keep allocation formulas in place, to assure that expense accumulated for a
parent-level class always gets fully allocated to its child-level subclasses.

If you re-use prior-period allocation setups when defining new accounting periods, you can
perpetually maintain allocation formulas which cause parent-level classes to always be fully
allocated to their immediate subclasses. This helps assure that you won't forget to allocate
expense accumulated for a parent class to its subclasses.

ManagePLUS Gold reminds you when a parent-level profit center class isn't
fully allocated to its subclasses, by displaying an amount in the Unallocated
column in red boldface text.

Why you need ManagePLUS Gold for
QuickBooks

"A picture's worth a thousand words", so the saying goes, and
hopefully the visual examples in this paper do a better job of
showing why you need ManagePLUS Gold than any verbal
description can. But here's a quick list of reasons why
ManagePLUS Gold can help your accounting processes, along
with links back to the examples and screen shots in this paper
which demonstrate them.

ManagePLUS Gold...

Lets you allocate income and expense by drag-and-drop between classes. No need to wrangle
with a calculator, spreadsheet, or debits and credits.

Lets you assign classes to "unclassified" income and expense balances—as when someone
failed to specify a class when entering the original transaction. This happens via the same 
drag-and-drop action, but from accounts to classes in this case.

Lets you allocate by entering percentages, or based on "management quantities" you've
associated with the destination classes for the allocations. For instance, you might associate a
number of staff hours or direct program spending with your program classes, then allocate
certain expenses to them on that basis. ManagePLUS Gold will handle all the calculations
automatically—including recalculating everything, if you should happen to adjust any of the
staff hours or direct program spending (etc.) entries.

Send Journal Entries to QuickBooks for the period's allocations, with a single click of the
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mouse. 

Reduces errors:  you never have to fiddle with a calculator or spreadsheet formula, and can
entirely avoid making journal entries manually.

Provides greater detail about the source of allocated amounts on your Profit and Loss by Class
reports. ManagePLUS Gold automatically manages an Other Expense-type account in the
QuickBooks Chart of Accounts, and maintains subaccounts which mimic the source classes of
the allocations, so allocation source detail automatically appears on your reports.

Supports using a more detailed set of classes if you want, because allocations "cascade"
through all of the classes they affect. For example:  if you allocate expense from Class1 to
Class2, and from Class2 to Class3, then Class1 will have contributed to the amount allocated
to Class3. (There's no limit on the number of class levels involved.) This gives you finer control
over allocating expense to the various areas of your organization...and thus, better
management information.

Lets you reuse your allocation setups for the "next" period's allocations. All you may need to do
is update the management quantities (staff hours, direct program spending) associated with
your classes. You may also adjust allocation formulas if desired, but often that won't be
necessary. In any case, ManagePLUS Gold will calculate new allocations based on the
updated management quantities and the accounting period's transaction amounts. 

Lets you re-create allocations for prior periods if necessary. ManagePLUS Gold maintains
each period's allocation setups for as long as you want, and can re-apply them at any time. If
an accounting error in January rendered January and February allocations incorrect, once
you've corrected the error you can apply updated allocation JEs for January and February in
minutes.

For more information

Visit the ManagePLUS Gold Web page, where you'll find descriptions, videos, and examples, as
well as a link to download and install a full-working version of the software, for a 30-day free trial:

 http://www.goflagship.com/products/mphome.htm

http://www.goflagship.com/products/mphome.htm
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